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Win-GRAF 快速上手手冊 

泓格科技股份有限公司 版權所有。 

 

泓格科技股份有限公司感謝您購買本公司的 Win-GRAF 系列控制系統，本系列產品結合方便整合

的特性以及強大的發展性，適用於各類工業用控制系統，並期望對使用 Win-GRAF 作為開發軟體 

的系統整合人員、程式設計師以及系統維護人員能有所助益。 

 

本公司出產的 Win-GRAF 可程式自動控制器 (PAC: Programming Automation Controller) 包括: 
 

ViewPAC-1000: VP-1238-CE7 

ViewPAC-2000: VP-2208-CE7, VP-2238-CE7 

ViewPAC-4000: VP-4208-CE7, VP-4238-CE7 

WinPAC-5000: WP-5238-CE7 

WinPAC-8000: WP-8148, WP-8448, WP-8848 

WP-8128-CE7, WP-8428-CE7, WP-8828-CE7 

XPAC-8000-CE6 XP-8048-CE6, XP-8348-CE6, XP-8748-CE6 

XP-8038-CE6, XP-8138-CE6, XP-8338-CE6, XP-8738-CE6 
 

注意事項 

泓格科技股份有限公司對於因為使用本系列產品所造成的任何損害並不負任何法律上的責任， 

本公司並保留在任何時候修訂本書且不需通知的權利。 

 

泓格科技股份有限公司將儘可能地提供本系列產品可靠而詳盡的資訊。然而，本公司並無義務需

提供此系列產品詳盡的應用資訊，或對因不當使用本系列產品所遭受的損害負任何責任。  

 

商標 與 著作權 

本書所提所有公司商標，商標名稱及產品名稱分別屬於該商標或名稱的擁有者所有。 

本書每一頁下方皆列有 版本資訊 與 發佈日期，若想取得較新的文件可以到 

http://ftp.icpdas.com/pub/cd/win-graf-workbench-cd/tutorials/  來下載。 

 

技術支援 

http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/win-graf/win-graf.html 
  

新版 Win-GRAF Workbench, Lib 與 PAC Driver: 

http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/win-graf/download/ 
win-graf-driver.html 
 

請連絡當地的經銷商或 E-mail 問題至  service@icpdas.com。 

 

版權所有泓格科技股份有限公司，2014 年 6 月起，保留所有權利。  

http://ftp.icpdas.com/pub/cd/win-graf-workbench-cd/tutorials/
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/win-graf/win-graf.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/win-graf/download/win-graf-driver.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/win-graf/download/win-graf-driver.html
mailto:service@icpdas.com
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第 1 章 軟體安裝 與 硬體設定 

1.1 安裝  Win-GRAF 軟體 

安裝 Win-GRAF 軟體前，請先確認您電腦中的安裝環境。 
 

系統需求: 

 作業系統:  Windows 7,  Windows 8 (32-bit 或 64 bit) 

 Microsoft .Net Framework 3.5 (可在微軟官方網站下載: 

http://www.microsoft.com/zh-tw/download/details.aspx?id=22) 

 RAM: 至少 1 GB  (建議 2 GB) 

 可用硬碟空間: 至少 200 MB 

 

安裝步驟: 

1. 於 Win-GRAF  安裝光碟中，滑鼠雙擊 “Win-GRAF-setup-ver-x.xx.exe” 檔開始安裝程序。 

(或 可上網下載最新版本的 Win-GRAF Workbench:  http://www.icpdas.com/root/product/ 

solutions/softplc_based_on_pac/win-graf/download/win-graf-driver.html) 
 
 
 
 
 

2. 點選 “Next” 進行下一步，接著選取 “I accept the agreement”  再點選  “Next” 繼續。 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.microsoft.com/zh-tw/download/details.aspx?id=22
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/win-graf/download/win-graf-driver.html
http://www.icpdas.com/root/product/solutions/softplc_based_on_pac/win-graf/download/win-graf-driver.html
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3. 建議使用預設的安裝目錄 (即，“C:\Win-GRAF”) ，並點選  “Next” 進行下一步。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. 點選  “Next” 於 “開始” 功能表中建立 “Win-GRAF” 捷徑目錄，可勾選 “Create a desktop icon” 建立

桌面捷徑，再點選  “Next” 進行下一步。 
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5. 點選 “Install” 開始安裝 Win-GRAF 軟體。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. 等待安裝完成，您會見到以下訊息視窗，此處說明了: 

a. 泓格科技合法授權的 Win-GRAF 軟體配備有一個 USB 保護鎖 (Win-GRAF Dongle)，開啟該軟體

前，請確認 USB 保護鎖已裝置在您的電腦中。 

b. 您的電腦必須安裝 “.NET FrameWork 3.5” 才能運行 Win-GRAF 軟體。 
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7. 您已完成 Win-GRAF 安裝，點選 “Finish” 離開此視窗。 

( 勾選 “Launch Win-GRAF” 將會自動開啟此軟體， 請確認您的 PC 已裝置了 Win-GRAF Dongle。) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.2 開啟  Win-GRAF 軟體 

開啟軟體前， 請確認您的 PC 已裝置了 USB 保護鎖 (Win-GRAF Dongle)。PC 若沒有插上 Win-GRAF 

Dongle，則 Win-GRAF Workbench 將以 Demo Mode 來運行。您可在 “開始” 選單中，點選 “Win-GRAF”

目錄再點選  “Win-GRAF” 來開啟軟體。 

 
 
 
 
 
 
 
 
 
 

Win-GRAF 目錄說明: 

Libraries:  可供使用者建立自訂的函式 或 修改內建的函式。 

Handbook: 原廠提供關於軟體介面、編程環境、編程語言…等詳細說明。 

(或 Win-GRAF 的功能表 [Help] > [Topics] ) 

History:  記錄 Win-GRAF 軟體更新內容的文字檔。  

Manual:  ICP DAS 提供的 Win-GRAF 相關手冊。 

(或 Win-GRAF 的功能表 [Help] > [Tutorials]，存放於 C:\Win-GRAF\Tutorials) 

ReadMe: 關於 Win-GRAF 版權相關資訊。 
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1.2.1 軟體操作模式 

 Win-GRAF 提供了兩種操作模式: 

“Demo Mode”: PC 未裝置 USB 保護鎖，表示 Win-GRAF 編譯出來的專案 (Project)  只能在 PAC 內 

                           運行 15 分鐘，時間超過後需再重新下載專案到 PAC 中，且只能使用 40 個 I/O 點。 

“Large Mode”: PC 有裝置 USB 保護鎖，表示 PAC 內的專案可一直 Run 沒有時間限制。 

 
Demo Mode 

若您的 PC 未裝置  Win-GRAF Dongle ，則軟體開啟時會先顯示以下畫面: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

註: 若於 [Demo Mode] 下裝置 Win-GRAF Dongle，需重新開啟 Win-GRAF 軟體來進入 [Large Mode]。 

 
Large Mode 

若您的 PC 已裝置  Win-GRAF Dongle，則軟體開啟時會先顯示以下畫面: 

 
 
 
 
 
 
 
 
 
 
 
 

未偵測到 Win-GRAF Dongle. Demo Mode! 

此處說明使用限制，

您也可在軟體功能表 

[Help] > [About] 查看

此說明。 



Win-GRAF 快速上手手冊,  1. 02 版,  2018 年 4 月      ICP DAS     1-8 

1.2.2 軟體介面說明 

開啟 Win-GRAF 後，畫面如下: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

註: 滑鼠右鍵點選視窗最上方可顯示/隱藏功能表。 
 

A. 工作區: 用來建立/開啟 Win-GRAF 程式的清單。 

B. 程式區: 用來顯示/編輯程式，可再分割為多個功能區塊 (參考 2.2.1 節)。 

C. 訊息區: 用來顯示編譯訊息，並提供多個診斷工具。 

 

使用小技巧:   

1. 可使用滑鼠拖曳的方式，任意調整視窗的大小。 

2. 可在工作區上按 “F1” 鍵，開啟使用說明。 

 

回復功能視窗 

若操作中不慎關閉了程式區的變數視窗 或是 訊息區，可點選 功能表 "View" 再選取下列選項來 

回復視窗。 

 
 
 
 
 

Output:  表示訊息區的視窗。 

Infos Tab1: 表示程式區 - 變數視窗 (參考 2.2.1 節)。 

Infos Tab2: 表示程式區 – 功能方塊視窗 (參考 2.2.1 節)。 

 
 

工作區 

 

A 

程式區 

 

B 

訊息區 

 

C 

功能表/ 工具列 
滑鼠右鍵 
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1.2.3 程式庫管理員 (Library Manager) 功能 

Win-GRAF Workbench 提供了程式庫管理員 (Library Manager) 功能，可用來查詢各函式 (Function)、

功能方塊 (Function Block) 與 I/O 卡 (I/O Board) 的功能說明，若想更新 Win-GRAF Lib 請參考 

Win-GRAF 使用手冊 11.1 節。 

 

1. 於 PC 的 “開始” 選單中，點選 “Win-GRAF” 目錄再點選 "Libraries" > “OEM”。 

 
 
 
 
 
 
 
 
 

2. 於 “Library Manager” 視窗中，點選功能表 “File” > “Open Library” 並選擇 “ICP DAS – XP-WP-VP” 再

點選 “OK”。 

3. 可在 “Function and FBs” 頁籤，點選下方的 “Description” 來查看各函式 (Function) 或 功能方塊 

(Function Block) 的說明；點選 “I/Os” 頁籤再點選下方的 “Description” 則可查看 I/O 卡 (I/O Board) 

的功能說明。 
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1.3 設定 Win-GRAF PAC 的 IP 位址 

Win-GRAF Workbench 需知道 PAC 的 IP 位址才能與之連線，以下將說明 PAC 端的 IP 設定。 

以 XPAC (XP-8xx8-CE6) 與 WinPAC (WP-8xx8, WP-8xx8-CE7, WP-5xx8-CE7) 為例: 

 

硬體連接圖 

 
 
 
 
 
 
 
 
 
 

PAC 端 

使用連接在 PAC 上的 USB Mouse 點選螢幕左下角的 “開始” > “設定” > “網路和撥號連線”，再雙擊 

LAN1 (或 LAN2)，並輸入適當的 IP 位址。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 

3 

點選可開啟鍵盤  
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於 PAC 桌面上 (或 \System Disk\tools\ 路徑下)，開啟 “WinPAC_Utility.exe” (或 “XPAC_Utility.exe”)，    

再點選 “File” > “Save and Reboot” 重新啟動 PAC。 

 

注意:  

PC/Win-GRAF 的 IP 與 PAC IP 需在同一個 IP 網段中，才連的上。 

例如:  PC 的 IP 設定為 192.168.1.20 (Mask: 255.255.255.0)。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Win-GRAF 快速上手手冊,  1. 02 版,  2018 年 4 月      ICP DAS     2-1 

第 2 章 編寫一個簡單的 Win-GRAF 範例 

本章將介紹一個簡單的樣版專案，可用來讀取或寫入 Win-GRAF PAC 中的系統時間。請依照以下 

步驟，一步步地實現此範例。 

2.1 建立 Win-GRAF 專案 

2.1.1 建立樣版專案 (Demo01) 

1.  開啟 Win-GRAF 軟體後 (可參考 1.2 節) ，點選 "File" 功能表再選擇 "Add New Project..." 選項。 

 
 
 
 
 
 
 
 
 

2.  點選 “From template” 來建立一個套用樣版的專案，於 "Name" 欄位中輸入專案名稱 (例如: 

Demo01)，並在 “Comment” 欄位中輸入此專案的註解，點選 "Next" 後，會出現 Win-GRAF 提供

的預設樣版 "ICPDAS_template"，請直接點選 "Next" 進行下一步。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

建議使用預設的專案目錄。 
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3. 您已建立一個 “Demo01” 樣版專案。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

注意:   本範例選用 “From template” 方式來建立新專案，若您在步驟 2 選擇了 "Project" 方式，

“Compiling options“ 請選擇 "Release"，其餘項目可在後續章節中進行設定，請點選 "下一步" 

再點選 "完成"。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

“PAC IP:502”， 

可參考 2.3.5 節。 
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2.1.2 重要專案設定 

建立專案後，有兩個需先完成的重要設定。 

1. 在 "工作區" 中，滑鼠右鍵點選專案名稱 (例如: Demo01)，並取消勾選  "Alphanumeric Sorting"  

(即最後一個選項) 。若不勾選，表示依執行順序來排列程式。若勾選，表示依字母順序來排列

程式 (例如: FBD1, LD1, ST1)。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

修改程式的執行順序: 

注意:  若您需修改程式的執行順序，(如上圖) 滑鼠右鍵點選專案名稱 (例如: Demo01) ，再點選  

"Cycle" 選項來開啟設定視窗，再點選 "Move Up" 或  "Move Down" 按鈕來挪動順序。 

 
 
 
 
 
 
 
 
 

2. 若選用 "Project" 方式 (見  2.1.1 節 - 步驟 2，本例選用 “From template” 方式) 來建立新專案，請

點選功能表 "Project" > "Settings..." 開啟專案設定視窗 (如下圖)，再點選 "General" 選項，並將 

"Complex variables in a separate segment" 設定為 "Yes"，以允許使用像是陣列的資料型態，再點

選 "OK" 離開設定視窗。 

 
 

 
 
 
 
 
 
 
 
 

(勾選，依字母順序) 

滑鼠右鍵。 

 
 
 
 
 
 
 
 
 

(不勾選，依執行順序) 
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注意: "Code Generation" 需設定在 "Release"。 
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2.2 專案介紹 

2.2.1 Demo01 - LD 程式 

此程式用來讀取或寫入 Win-GRAF PAC 中的系統時間。於工作區中，滑鼠雙擊 LD 程式名稱 (即，

“PAC_Time") 來開啟相關的視窗。如畫面中，程式區 劃分為 3 個區塊: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

使用小技巧:  滑鼠點選一下程式編輯區，再按  "+"  或 “-” 鍵，可放大或縮小程式內容。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

A. 程式編輯區 (LD):   

此區塊用來編輯/顯示 LD 程式，您可點選左邊的元件按鈕來新增程式，也可用滑鼠拖曳方式將

定義好的變數指定給功能方塊。 

 
 

A. 程式編輯區 (LD) 

B. 變數區 

C. 功能方塊區 
註:   表示目前為

鎖定，不可刪除。 

程式區 

 

例如: 按兩次 "-” 鍵，

縮小程式內容。 
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B. 變數區: 

此區塊顯示了程式中使用的 功能方塊 與 變數。滑鼠雙擊任一 “Name”  或 “Type” 項目，可修改

其名稱 或 資料型態，再按 “Enter” 鍵完成修改。關於變數的定義方式，請參考  2.3.1 節。 

 

註:  程式內每增加一個功能方塊都會自動建立一個 

“Inst_xxx..” 樣例變數，這樣才能正確使用功能方塊。 

但若刪除程式的功能方塊時，為了安全並不會自動刪除

變數區的樣例變數，因此使用者可用滑鼠右鍵點選名稱

再選擇  “Clear” 來刪除不需使用的樣例變數。 

 
 
 
 
 
 
 
 
 

C. 功能方塊區: 

此處 (“Blocks” 頁籤) 提供了許多類型的功能方塊，您可依需求將功能方塊拖曳到程式的編輯區。 

 
 
 
 
 
 

 
 

使用小技巧:  

選取功能方塊後，按 “F1” 鍵

可開啟該功能的使用說明。 

R1: 讀取 PAC 目前時間 R2: 將 “Set_new_time” 設為 “True”，可寫入新的時間 

R3: 重置為 “False”狀態 

樣例變數 

註: 您可點選空白鍵來變更其型態 

(/, S, R)，按 F1 鍵可取得詳細說明。 
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2.2.2 Demo01 - 變數說明 

工作區中，滑鼠雙擊 “Variables” 項目來開啟變數視窗，此處列出了所有 “Demo01” 專案中需使用、

已定義好的變數。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

使用小技巧:   在變數視窗中，可點選任一標題欄位 (例如: “Name”) 來進行排序。 

若要恢復原有排序，以滑鼠右鍵點選視窗內任一處並選擇 “Cancel Sorting”。 

 
 
 
 

 
 

欄位說明:  (可按 “F1” 鍵，查看詳細說明) 

可用滑鼠雙擊任一個欄位項目，來進行設定/修改。 
 

Name:  變數名稱，無大小寫的區別，都視為相同可使用的字元。 

名稱只能是 A ~ Z (或 a ~ z)、 0 ~ 9 與 “_” (底線字元)，而且第一個字必需是英文字元。 

Type:  資料型態。 (數值範圍，請參考 附錄 A) 

Dim.:  可供陣列使用 (例如: 輸入 “10” 來表示 Counter [0] ~ Counter [9]) 。 

Attrib.:  若滑鼠雙擊此欄位，會設定為 “Read Olny” 表示該變數只能讀取，不可變更值。 

Syb.:  若勾選，會將變數名稱也下載至 PAC 中。 

Init value:  可輸入變數的初始值。 

User Group:  可將變數分成群組 (例如: 群組 1, 2)，以方便查看、搜尋變數。 

Tag: 可輸入易於辨識的名稱 (Nick name)。 

Description: 可輸入變數的用途說明。 

 
 
 
 
 

點選後，依名稱排序。 
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2.3 小試身手 

在前述章節中，分別介紹了 “Demo01” 專案中的 LD 程式 (2.2.1 節) 與 變數說明 (2.2.2 節)，本章節將

在此專案中練習如何宣告變數與新增一個提供閃爍功能的 LD 程式。  

注意: 所有的 Win-GRAF PAC 皆不支援 “ULINT” 與 “LWORD” 資料型態。 

2.3.1 宣告專案變數 

首先，我們將宣告 2 個布林變數 (即，LED1 與 LED2) 可供程式使用。 

1. 在 “Variables” 視窗中，滑鼠右鍵點選任一個 “Name” 項目，再選擇 “Add Variable”  或 按鍵盤  

"Ins" 或 點選工具按鈕   來新增一個變數。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 滑鼠雙擊新增的 “NewVar” 項目將名稱修改為 “LED1”，再按 “Enter” 完成設定。 

此例，資料型態為 "BOOL"。  

 
   
 
 

注意:  所有的修改都必須按 “Enter” 才能完成設定。 

 

3. 如同上述步驟，請再新增 “LED2” 布林變數。 

 
 
 
 
 
 

使用小技巧:  對於有連續順序的變數，在步驟 2 可改以輸入 “LED” 再以複製 (Ctrl+C) 並貼上 (Ctrl+V) 

的方式 自動產生編號 (即，“LED1”、“LED2”)，最後再刪除 “LED” 即可。 
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使用小技巧 2:   

甲、 若需新增多個變數時  (例如: “Boo_01 ~ Boo_16”)，滑鼠右鍵點選 “Global variables” 再選擇  

“Add Multi Variables”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

乙、 如圖，輸入以下設定值 (Name:  “Bool_%%”；Type:  “BOOL”；From: 1；To: 16) 來建立名稱為 

“Bool_01” ~ “Boo_16” 的布林變數，再點選 “Create all” 完成設定。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

滑鼠右鍵 
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2.3.2 宣告 I/O 變數 

此範例中，會在 PAC 的 Slot 1 插上一片 I-8055W 模組來顯示閃爍功能。因此，在 “Demo01” 專案中，

需新增 I/O 連結來對應到 PAC 中的 I/O 模組。 

 

1. 點選工具列的 "Open I/Os" 按鈕來新增 I/O 連結。 

 
 
 
 

2. 滑鼠雙擊 "Slot 1" 再雙擊 "i_8055" 以完成 I/O 選取。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. 點選 “Close” 離開 “I/O Boards” 視窗。 

註: 可點選 “Virtual/Real” 來切換為 虛擬 I/O (測試用) 或 真實 I/O，此處使用真實 I/O。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

虛擬 I/O:  (顯示藍色) 
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剛剛在 I/O Board 內連上 “i_8055” 後，會自動在 “Variables” 視窗中新增 8 個 Input 與 Output 變數 

供程式使用。 

 

 
 

%IX1.0 – i_8055_DI  
I : 表示 “Input” 

X : 表示 “Boolean” 

1 : 表示 “Slot 1” 

%QX1.1 – i_8055_DO 

Q : 表示 “Output” 

X : 表示 “Boolean” 

1 : 表示 “Slot 1” 
 

%ID   或  %QD 

D : 表示 “Integer/Real” 

 

 

此範例中需使用 3 個 Output 變數，您可修改變數名稱以方便識別。 

滑鼠雙擊欲使用的項目，輸入名稱後按 “Enter” 鍵完成設定。 
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2.3.3 建立 LD 程式 

在 “Demo01” 專案中，我們將新增一個名稱為 “LD1” 的程式，用來產生閃爍功能。 

1. 工作區中，滑鼠右鍵點選 “Programs” 再選擇 “Insert New Program…”。 

 
 
 
 
 
 
 
 
 
 
 

2. 於  “Name” 欄位中填入程式名稱，並在 “Desciption” 欄位加入簡單的描述。接著，選取  

“LD – Ladder Diagram” 編程語言，再點選 “確定”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. 滑鼠雙擊 “LD1” 程式來開啟編輯視窗。 
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4. 點選 “LD1” 視窗左側的 “Insert FB..” 按鈕來加入一個功能方塊 (Function Block)。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. 滑鼠雙擊此功能方塊，並選取 “BLINK” 再按 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

使用小技巧:   

您也可直接將 “BLINK” 功能

方塊拖曳到編輯視窗中。  

使用小技巧:   

您可按鍵盤 “BL” 來快速 

跳到名稱項目。  

使用小技巧:  (參考 2.2.1 節 – B) 

點選上半區塊，可選擇不同的樣例變數，

點選下半區塊，可選擇不同的方塊種類。 
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重要注意事項: 

 

使用者在編輯程式時，可能會以複製並貼上的方式來新增功能方塊，但此方式會造成功能方塊

的樣例變數名稱重複，而導致功能異常。因此，請務必再建立一個新的 樣例變數 名稱。 

 

1. 滑鼠雙擊該功能方塊，並輸入新的名稱 (例如: “Inst_BLINK1”)，再點選  完成設定。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 於 “Inst_BLINK1” 變數視窗中，點選 “Yes” 來建立此樣例變數。 

 
 
 
 
 
 
 
 
 
 
 

3. 變數區已建立了一個名稱為 “Inst_BLINK1” 的樣例變數。 

 
 
 
 
 
 
 
 
 
 

 
 

2 

3 

使用小技巧:   

您也可依照相同的方式，滑鼠雙擊

功能方塊旁的 “Coil” 來 新建/指定

一個變數 (參考下方步驟 7)。 

1 
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6. 點選  “BLINK” 功能方塊右方的 “Coil”，再連續點選 “Insert Coil” 按鈕來新增 4 個 “Coil”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. 滑鼠雙擊第一個  “Coil”  再雙擊 “LED1” 來指定變數。依照同樣的方式，將第二個 “Coil” 指定為 

“LED2” 變數。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. 接著，可用滑鼠拖曳方式來指定 “Output1”、 “Output2”、 “Output3” 變數。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 

使用小技巧:  按鍵盤  “+” 可放大程式內容。  

按 SPACE 鍵可變更 Coil 的型態 (/, S, R) 
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9. 滑鼠雙擊 “CYCLE” 的左側，並輸入 “T#2S”  (表示每 2 秒閃爍一次)，再點選  完成設定。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. 最後，點選 “Save” 按鈕，儲存 “LD1” 程式。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

註:    表示該程式目前為開啟狀態 (鎖定，不可刪除)，可點選程式區右上角的 “X” 來關閉 

程式視窗 (解除鎖定， )。  
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程式編輯完成後，若您想在程式的最上方新增一行程式: 

 

1. 滑鼠點選程式編輯區的左上角，此時元件區會顯示可點選的項目，點選元件按鈕 (如圖，4 ~ 7) 

可在第一行加入程式。 

註: 若點選元件按鈕 (如圖，1 ~ 3) 則會在程式的左方加入一行程式。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 此例，點選  “Insert new rung” 可在第一行加入程式。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

程式上方加入一行: 

4. Insert jump (shift + F9) 
5. Insert Coil (F9) 
6. Insert new rung 
7. Insert commecnt line 

程式左方加入一行: 

1. Insert contact before (shift + F4) 
2. Insert horizontal line (shift + space) 
3. Insert FB before (shift + F8) 
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2.3.4 編譯程式 

在上一節中，我們已新增並儲存了 LD 程式，為了讓 Win-GRAF 程式可在 PAC 上正常運作，接下來

要進行程式編譯。 

 

1. 點選功能表 “Project” 再選擇 “Build All Projects”  開始編譯程式。 

 
 
 
 
 
 
 
 
 

2. 若訊息區中出現 “No error detected” 表示編譯成功。 

注意:  若編譯完成後，又再修改並儲存程式，請先點選 (上圖) “Clean All Projects” 清除先前的 

編譯結果並再執行編譯一次。 

 

 
 
 
 
 
 
 
 
 
 
 

若使用 Demo Mode，"Build” 訊息區

會提示 PAC 中的 Win-GRAF 專案只

能運行 15 分鐘。 

此處可查看是否有錯誤訊息。 
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2.3.5 下載程式到 PAC 

下載程式之前，請先設定好通訊參數 (僅支援 Ethernet 通訊埠的方式)。 

 

1. 滑鼠右鍵點選專案名稱 (即，Demo01)，再選擇 “Communication Parameters…” 開啟設定視窗。 

 
 
 
 
 
 
 
 
 
 

2. 填入 “PAC IP:502” (例如: “192.168.255.1:502”) 來新增一個 IP 選項，並按 “OK”。 

也可點選    按鈕，來新增 或 修改 IP 位址。 

 (註: PAC IP 出廠預設為 192.168.255.1，Port 號固定為 502) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. 建立連線前，請確認您的 Win-GRAF PAC 已經開機且網路通訊正常。 

 

使用小技巧:  設定過的選項會列於此處，如需刪除

多餘的項目，點選該  IP 選項再按 “Del” 鍵。例如: 
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4. 點選功能表 “Project” 再選擇 “On Line”，或點選工具按鈕   來與 PAC 建立連線。 

 
 
 
 
 
 
 
 
 
 
 

5. 如圖，若出現 “App: TEST” 字樣 (與目前專案名稱 “Demo01” 不同)，表示 PAC 內已有一個正在

運行的專案 (名稱: “TEST”)，請點選工具按鈕 “Stop application” 停止該專案運行。 

 
 
 
 

 
6. 接著，點選工具按鈕 “Download” 來下載 “Demo01” 專案。 

 
 
 
 
 
 
 
 
 

7. 若出現 “RUN” 字樣，表示連線成功且 “Demo01” 專案運行中。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

顯示目前 PAC 系統時間。 
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註: 若下載過程中有出現錯誤訊息，請參考 附錄 B 來排除問題。 

 
Cycle time 

在連線的狀態下，滑鼠移到工具列 “RUN” 的位置可查看目前 PAC 內程式的  Cycle time。 

您也可在右下方的訊息區中查看此資訊。 

 

 
 

執行連線時 ( )，會自動切換到 “Runtime” 訊息區，您可在此查看下載到 PAC 中的程式是否出現

錯誤訊息。 (例如: “Board error in the slot No. 1 !” 表示 PAC 的 Slot 1 上無插上 I/O 模組或是有異常，

此例需在 PAC 的 Slot 1 插上 I-8055W 模組。)  

 

請將 PAC 關機，插上 I-8055W 模組後再重新開機，並再執行連線時 ( ) 一次。 
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2.3.6 測試程式 

上一章節中，已成功的下載 “Demo01” 專案，接下來要介紹如何測試程式。 
 

“PAC_Time” 程式: 

1. 在 “TIME_SET” 功能方塊中 (或變數區中)，滑鼠雙擊 各變數名稱 (例如: “new_Year”) 來依序修改

系統時間。(假設:  將資料改為 2015 年 1 月 1 日，12 點 30 分 35 秒。) 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 將 “Set_new_time” 變數設定為 “TRUE” 以寫入新的系統時間。 
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3. 在 “TIME_GET” 功能方塊中 (或變數區中)，顯示了新設定的 PAC 系統時間，且 “Set_new_time” 

變數會自動重置為 “FALSE” 。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

“LD1” 程式: 

4. 當 “Demo01” 專案運行時，可查看 PAC 上 (Slot 1) 的 I-8055W I/O 模組 - DO0、DO1、DO2 是否

如同設定值 (即，"T#2S" 表示每 2 秒閃爍一次)。您也可改為在 “CYCLE” 左側指定一個資料型態

為 “TIME” 的變數，設定方式參考 2.3.1 節，以便修改時間設定。) 

5. 若將變數區的 “%QX1.1.3” 設定為 “TURE”，可見到 I-8055W I/O 模組 – DO3 的燈號為亮。 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

6. 您可再次點選工具按鈕   來取消與 PAC 的連線。 

注意:  請勿點選 “Stop Application” 來停止連線，這會停止 PAC 中運行的程式。 

顯示 PAC 系統時間。 

新設定的 PAC 系統時間。 
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第 3 章 Modbus Slave: 開放 Win-GRAF PAC 與  

圖控/HMI 軟體來相互溝通 

在第 2 章的 “Demo01” 專案中，說明了如何讀/寫 PAC 中的系統時間 (即 “PAC_Time” 程式) 與一個 

閃爍功能 (即 “LD1” 程式)，此章節將提供 “Demo01” 專案中的變數，讓圖控軟體 (例如: 泓格科技的 

“InduSoft”) 或 HMI 軟體來進行存取。Win-GRAF 軟體提供了兩種方式，可開放 PAC 中的資料，一種

是啟用 Win-GRAF PAC 為 Modbus TCP Slave，另一種是啟用 Win-GRAF PAC 為  Modbus RTU Slave (需

先完成 3.1 節 Modbus Slave 設定，見 3.2 節) ，請依照以下內容來進行設定。 
 

3.1 啟用 Win-GRAF PAC 為 Modbus TCP Slave 

1. 滑鼠點選工具列上的 “Open Fieldbus Configuration” 按鈕來開啟 “I/O Drivers” 視窗。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 點選 “I/O Drivers” 視窗左側的 “Insert Configuration” 按鈕，再點選 “MOSBUS Slave” 並點選 “OK” 

來啟用一個  Modbus TCP Slave。 

 
 
 
 
 
 
 
 
 
 
 
 

http://www.icpdas.com/products/Software/InduSoft/indusoft_tc.htm
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3. 點選左側的 “Insert Master/Port” 按鈕，並設定 “Slave number” (此例為 “1”)，再點選 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. 點選左側的 “Insert Slave/Data Block” 按鈕，來開啟 “MODBUS Slave Request” 設定視窗。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. 在 “Description” 填入識別的資訊並 

點選  "Input Registers" 選項。 
 

可供 Modbus Master 讀取資料: 

選項 資料型態 

Input Bits BOOL 

Input Registers 
BYTE, INT, DINT, 

REAL, …等。 
 

可供 Modbus Master 寫入資料: 

選項 資料型態 

Coil Bits BOOL 

Holding 
Registers 

BYTE, INT, DINT, 

REAL, …等。 

(資料型態，可參考附錄 A) 

使用小技巧:   

1. 按 “F1” 鍵，可查看詳細的設定說明。 

2. 若新增兩個以上的 “Server - …” 設定，可填寫 

“Server ID” (字串，例如: `SVR1’) 以方便識別。 

填入識別資訊 

建議設定 “Base address” 

為 “1” 並設定 “Nb items” 

為大於 200 的數值。  
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6. 如上圖，建議將 “Base address” 設定為 “1”，而 “Nb items” 表示一個 “Data block” 最多可提供多少

個變數資料，若 Modbus Master (例如，圖控軟體) 要求的資料位址大於此數值  (此例設定為 

“2000”)，則 Modbus Slave (即，Win-GRAF PAC) 將不回應。 

7. 將變數區的變數 (此例為 “PAC_xxx”，資料型態: DINT) 以滑鼠拖曳的方式，拉到 “Symbol” 區塊。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

8. 滑鼠雙擊 “Offset” 欄位並填入數值後，按 “Enter” 完成設定。 

注意:  (1) “Offset” 的值是由 “0” 開始，而 “Offset” 的值加 1 (Base address) 才是該變數的 

       Modbus 位址。 

(2) 若選用的是 32-bit 或以上的資料型態 (此例為 DINT)，則需佔用 2 個 Modbus 位址 

      如下表，“0, 2, 4, 6, ….”。(更多關於資料型態，可參考附錄 A。) 

 
 
 
 

 
 
 
 
 

使用小技巧:  

滑鼠點選任一欄位再按 “Ctrl+A” 全選，點選左側的 “Iterate Property” 按鈕，開啟設定視窗。 

 
 
 
 
 
 
 
 
 

Enter 

Ctrl+A 
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“Name” 維持設定 “ % ”、將 “From” 填入 0、“By” 填入 2，再點選 “OK”。 
 

(若 Name 修改為 “ %% ”，此例會顯示為 00, 22, 

44, 66, 88, 1010, 1212，您可依實際需求來修改，

並查看 “Results” 的顯示結果) 

 
 
 
 
 
 

 
 
 
 
 

9. 滑鼠點選 “Storage” 來選取整欄，再按 “Enter” 鍵顯示下拉選單，接著選擇 “DWORD (Low – High)” 

再按 “Enter” 鍵完成設定。(若資料為 16-bit 或以下，不需設定 “Storage” 項目 ) 

 
 
 
 
 
 
 
 
 
 
 
 

您可展開這個 “Data Block”，如圖， “Offset” 的值加 1 (Base address) 為該變數的 Modbus 位址。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Win-GRAF 快速上手手冊,  1. 02 版,  2018 年 4 月      ICP DAS     3-5 

10. 接著，需再新增一個 “Data Block” 用來供  Modbus Master 讀取 Boolean 資料。  

設定方式與步驟  4 ~ 8  類似: 

(1) 滑鼠點選 “Server - …” 再點選左側的 “Insert Slave/Data Block” 按鈕，來開啟設定視窗。 

(2) 設定視窗中，填入識別資料後，選擇供讀取的選項 “Input Bits”、設定 “Base address” 為 “1”、 

      設定 “Nb items” 為 “2000”。 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

(3) 將變數區的 BOOL 變數 “LED1”、“LED2” 拖曳到 “Symbol” 區域並設定其 “Offset” 為 “0”、 “1”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

您已完成 Modbus Slave 設定，接下來請重新編譯並下載程式到 Win-GRAF PAC 中。 

 
 
 
 
 
 

填入識別資訊 

可供 Modbus Master 讀取資料: 

選項 資料型態 

Input Bits BOOL 

Input Registers 
BYTE, INT, DINT, 

REAL, …等。 

 (資料型態，可參考附錄 A) 
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11. 點選功能表 “Project” > “Build All Projects”  重新編譯程式 (參考 2.3.4 節)。 

出現 “No error detected” 表示編譯成功。 

 
 
 
 
 
 
 
 
 
 

12. 滑鼠右鍵點選專案名稱 (即，Demo01)，再選擇 “Communication Parameters…” 設定 PAC IP (例如: 

192.168.71.19:502)，點選功能表 “Project” > “On Line” (或   ) 來建立連線，並將專案下載到 

Win-GRAF PAC 中  (參考 2.3.5 節)。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(您可參考第一頁，來查看所有支援的 PAC 型號) 
 

如此之後 HMI 或 SCADA 軟體便可使用 Modbus TCP protocol 來存取以上所列的、有設定 Modbus 

位址的 Win-GRAF 變數。 

 
 
 

此編譯訊息為版本資訊，可忽略。 

Modbus TCP Slave 

SCADA / HMI Win-GRAF PAC 

IP: 192.168.71.19 
Port: 502 

InduSoft 

Modbus TCP Master 

Slave number = 1 
IP: 192.168.71.xxx 
Mask: 255.255.255.0 

WP-5xx8-CE7 WP-8xx8 
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3.2 啟用 Win-GRAF PAC 為 Modbus RTU Slave 

開始前，您必須先完成  3.1 節 中的內容、設定好需開放的 Modnus Slave 資料。啟用 Win-GRAF PAC 

為 Modbus RTU Slave 的方式為，在程式中加入 “MBSLAVERTU” 或 “MBSLAVERTUEX” 功能方塊， 請

依照下列說明來完成設定。 

 

加入 “MBSLAVERTU” 功能方塊 

1. 在 “LD1” 視窗中，滑鼠點選需加入功能方塊的位置，再點選左側的 “Insert FB..” 按鈕。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 滑鼠雙擊此功能方塊，並選取 “MBSLAVERTU” 再按 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

使用小技巧:   

按鍵盤 “MBSL” 可快速

跳到接近的名稱。  

1 

2 

3 
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3. 於  “MBSLAVERTU” 功能方塊，滑鼠雙擊 “PORT” 左側的區域並輸入字串 'COM2:9600,N,8,1' (表示

使用 Win-GRAF PAC 的 COM2 與 Modbus Master 進行溝通)，再點選  完成設定。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. 滑鼠雙擊 “SLV” 左側的區域並輸入 “1” (即 3.1 節 - 步驟 3 設定的值)，再點選  完成設定。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

您已完成 “MBSLAVERTU” 功能方塊的設定，接下來請重新編譯並下載程式到 Win-GRAF PAC 中。 

(參考 2.3.4 節，2.3.5 節) 

 

注意:  同一台 PAC 內可啟用多個 Modbus RTU Slave (建議不超過 16 Port)，方法為新增多個 

“MBSLAVERTU” 功能方塊，並輸入不同的 Port 編號。 

 
 

使用小技巧:   

在功能方塊上按  “F1”  

可查詢詳細說明。  
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(您可參考第一頁，來查看所有支援的 PAC 型號) 

加入 “MBSLAVERTUEX” 功能方塊 

若您在 “I/O Drivers” 中建立多個 “Server - …” 設定 (建議只使用一個)，則需使用 “MBSLAVERTUEX”  

功能方塊。 

 
 
 
 
 
 
 
 
 
 
 

1. 您可依照上述步驟 1 ~ 4 來建立一個 “MBSLAVERTUEX” 功能方塊。若您想變更先前已建立的功能 

方塊，可用滑鼠雙擊 “MBSLAVERTU” 並重新選取為 “MBSLAVERTUEX”，再點選 “OK”。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Modbus RTU Slave 

SCADA / HMI 

InduSoft 

Modbus RTU Master 

COM2: RS-232 
9600,N,8,1 

Win-GRAF PAC 

Slave number = 1 
WP-5xx8-CE7 WP-8xx8 
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2. “MBSLAVERTUEX” 多了一個 “SrvID” 設定項目，滑鼠雙擊 “SrvID” 左側再填入所需的  “Server ID” 

(字串格式，例如 ‘Svr1’)。 

注意: 

若使用 “MBSLAVERTU” 功能方塊，只會參考第一個 “Server – Slave number..” 設定。 

若使用 “MBSLAVERTUEX” 功能方塊，則會參考具有相同 “Server ID” 的  “Server – Slave…” 設定。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

您已完成 “MBSLAVERTUEX” 功能方塊的設定，接下來請重新編譯程式並下載到 Win-GRAF PAC 

中。(參考 2.3.4 節，2.3.5 節) 

 
 
 
 
 
 
 
 
 
 
 
 
 

使用小技巧:   

在功能方塊上按  “F1”  

可查詢詳細說明。  
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附錄 A 資料型態與數值範圍 

您可在程式的變數區 (參考 2.2.1 節) 或 變數視窗 (參考 2.2.2 節) 中設定變數的資料型態。 

 
 
 
 
 
 
 
 
 
 
 

下表為變數的基本資料型態與數值範圍: 

 

資料型態 位元數 數值範圍 

BOOL (*) --- TRUE，FALSE 

SINT 8 bits (Small int, signed) -128 ~ +127 

USINT 
8 bits (Unsigned small int) 0 ~ +255 

BYTE 

INT  16 bits (Int, signed) -32768 ~ +32767 

UINT 
16 bits (Unsigned int) 0 ~ +65535 

WORD  

DINT (*) 32 bits (Double int, signed) -2147483648 ~ +2147483647 

UDINT 
32 bits (Unsigned double int) 0 ~ +4294967295 

DWORD 

LINT 64 bits (Large int, signed) -263 ~ +(263-1) 

ULINT 
64 bits (Unsigned large int) 0 ~ +(264-1) 

LWORD 

注意: 所有的 Win-GRAF PAC 皆不支援 “ULINT” 與 “LWORD” 資料型態。 

REAL (*) 32 bits (Floating point) ±3.4×10-38 ~ ±3.4×1038 

LREAL 64 bits (Floating point) ±1.7×10-308 ~ ±1.7×10308 

STRING (*) 最多 255 個字元 --- 

TIME (*) 32 bits T#0ms ~ T#23h59m59s999ms 

(*): 表示常用的資料型態 
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附錄 B 錯誤訊息排除 

若  PC 與 PAC 之間的連線出現了錯誤訊息，請參考以下內容來排除問題。 

 

 若出現 “Bad version!” 錯誤訊息: 

表示程式有修改並重新編譯過，因此 PC 與 PAC 中的程式 (編譯) 版本不一致。 

 

1. 點選 “Stop application” 按鈕，停止 PAC 中運行的程式。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 再點選 “Download” 按鈕，重新下載程式。 

 
 
 
 
 
 
 
 
 

3. 出現 “RUN” 表示程式正常運行。 
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 若出現 “Communication error” 錯誤訊息: 

表示 PC 與 PAC 之間通訊失敗。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 確認您的 Win-GRAF PAC 已經開機且網路通訊正常。 

2. 確認 PAC IP 與專案中的設定一致 (參考 2.3.5 節，此例為 “192.168.255.1:502”)。 

3. 確認您的 PC 網路通訊正常。 
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